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Safety Information
Important Information

NOTICE Read these instructions carefully, and look at the equipment to become familiar with the 
device before trying to install, operate, or maintain it. The following special messages 
may appear throughout this documentation or on the equipment to warn of potential 
hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of this symbol to a Danger or Warning safety label indicates
that an electrical hazard exists, which will result in personal injury if the
instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER indicates an imminently hazardous situation, which, if not avoided, will 
result in death, serious injury, or equipment damage.

DANGER

WARNING indicates a potentially hazardous situation, which, if not avoided, can result 
in death, serious injury, or equipment damage.

WARNING

CAUTION indicates a potentially hazardous situation, which, if not avoided, can result 
in injury or equipment damage.

CAUTION
  35007035 04 03/2006 5



Safety Information
PLEASE NOTE Electrical equipment should be serviced only by qualified personnel. No responsibility is 
assumed by Schneider Electric for any consequences arising out of the use of this 
material. This document is not intended as an instruction manual for untrained persons.

© 2005 Schneider Electric. All Rights Reserved.
6   35007035 04 03/2006



About the Book
At a Glance

Document Scope This manual introduces you to the fundamentals of Vijeo Designer, a software 
package you need to use when you develop and configure applications for the 
XBT G/XBT GT families of HMI panels.

It is written to help new users get started and as a quick reference for users who are 
already familiar with the software. For detailed descriptions of the software’s feature 
and functions, refer to the Vijeo Designer online help.

Related 
Documents

User Comments We welcome your comments about this document. You can reach us by e-mail at 
techpub@schneider-electric.com

Title of Documentation Reference Number

Vijeo Designer User Manual included on the Vijeo Designer CDROM

Vijeo Designer Uni-Telway Driver included on the Vijeo Designer CDROM

Magelis XBTG Modbus TCP/IP Driver included on the Vijeo Designer CDROM

Magelis XBTG Modbus RTU Driver included on the Vijeo Designer CDROM

Magelis XBTG Modbus Plus Driver included on the Vijeo Designer CDROM
  35007035 04 03/2006 7



About the Book
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Vijeo Designer at a Glance
At a Glance

Purpose of this 
section

This section describes the software’s main functions and installation.

What's in this 
Part?

This part contains the following chapters:

Chapter Chapter Name Page

1 General 11

2 Project creation 19

3 Project Download 67
9
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General
At a Glance

Purpose of this 
chapter

This chapter describes the Vijeo Designer software application.

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

Software Overview 12

Vijeo Designer's Main Tools 14

Installing Vijeo Designer 16

Software Version Compatibility 17

Uninstalling Vijeo Designer 18
11



General
Software Overview

About Vijeo 
Designer

Vijeo Designer is a state-of-the-art software application with which you can create 
operator panels and configure operating parameters for human machine interface 
(HMI) devices. It provides all the tools needed to design an HMI project, from the 
data acquisition to the creation and display of animated drawings.

Minimum System 
Requirements

 

Features Data reuse

Vijeo Designer uses two types of data:

internal data created in the user application
data provided by external devices such as PLCs and remote I/O modules

Graphical objects, scripts, and panels created with Vijeo Designer can be saved in 
the Toolchest (See Vijeo Designer's Main Tools, p. 14) so that they can be reused in 
other projects. The ability to reuse this data can help you optimize the development 
of new applications and standardize screens in applications that are co-developed.

Multi-PLC connectivity

With Vijeo Designer you can configure your HMI panel to simultaneously 
communicate with several different Telemecanique and third-party devices.

HMI screen creation

Vijeo Designer enables you to create dynamic screens for the HMI panel. It 
combines various functions such as moving objects, zooms, level indicators, on/off 
indicators, and switches in a simple application. Animated symbols can be used to 
build and edit a graphical screen very simply.

Scripts

Vijeo Designer provides a script feature so that you can reuse building blocks or full 
sequences from one application in other projects.

Processor Intel Celeron 566 MHz or faster (Pentium III 1GHz or faster 
recommanded)

Memory 128 MB of RAM (512 MB or more recommended)

Available Disk Space 400 MB or more on hard disk

Operating system Windows 2000 or XP (english, french, gernan, italian or spanish)

Web browser Internet Explorer 5.0 or later
12   35007035 04 03/2006



General
Reports

Vijeo Designer incorporates an advanced function that simplifies the management 
of variables used in the animation screens. Working in a Property Inspector window 
(See Vijeo Designer's Main Tools, p. 14), you can configure or modify the variables 
and characteristics of objects.

Multi-language messaging

Vijeo Designer can store the alarm messages or text objects for the same 
application in more than 10 different languages. A simple selection from the 
animation screen switches the display to the selected language.

Editing variables from other applications

Vijeo Designer can import/export variables and recipes as CSV files. Similarly, 
variables created in Vijeo Designer can be exported to other applications.

Target Terminal 
Models

The following HMI units are designed and configured with Vijeo Designer:

XBT G2000 Series
XBT G4000 Series
XBT G5000 Series
XBT G6000 Series
XBT GT1000 Series
XBT GT2000 Series
  35007035 04 03/2006 13



General
Vijeo Designer's Main Tools

At a Glance Vijeo Designer's main tools can be accessed from the program's main screen. Six 
tool windows enable you to develop your project quickly and easily. Each window 
provides information pertaining to a specific object or to the project.

You can customize your work environment by resizing or moving the windows. Icons 
associated with the windows are located in the toolbar.

The Main Screen The Vijeo Designer environment looks like this: 

A
A 123

A !

ToolsFile Edit Build Search View DrawArrange HelpWindowHMI Variable Report
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Vi
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For Help, press F1
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Graphic screen where work in 
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Note: Vijeo Designer appearance may be different, because all the  windows can 
be configured by user.
14   35007035 04 03/2006



General
Working Window 
Icons

The tool window icons (identified in the illustration above by the numbers 1-6) act as 
toggle switches to display or hide the working windows:

Item Screen/Icon name Description

1 Navigator  Used to create applications. Information about each project is listed hierarchically in a 
document explorer.

2 Property Inspector Displays the selected object's parameters. When more than one object is selected, only 
those parameters common to all objects are displayed.

3 Graphics list Lists all the objects appearing in the drawing, giving their:
creation order
name
position
animations
other associated variables

The highlighted object in the list is selected in the drawing.
Information is displayed similarly for a group of objects (i.e., order, name, position). To 
display a list of the objects in a group, click +. Each object can be selected separately.

4 Feedback Zone Displays the progress and results of the error check, compilation, and load.
When an error occurs, the system displays an error message or warning message. To 
view the error location, double-click the error message.

5 Toolchest A library of components (bar chart, timers, etc.) provided by the manufacturer and/or 
created by you. To place a component in the drawing, select the component in the 
Toolchest and drag it into the drawing.
Your own components can be exported and/or imported.

6 InfoViewer Displays the online Help or the contents of a report

!

  35007035 04 03/2006 15



General
Installing Vijeo Designer

Prerequisites Vijeo Designer software should be installed by a system administrator.

Installation 
Procedure

 

Step Action Result

1 Close any applications running 
on the desktop.

2 Insert the CD-ROM in the 
computer's CD drive.

Vijeo Designer's Autorun program should 
automatically start the installation program. If the 
installation does not begin automatically, click Start → 
Run, enter x:\SETUP.EXE in the Open box, and click 
OK (where x represents your CD-ROM's drive letter).

3 Select an installation language and 
click the Vijeo Designer button.

The InstallShield Wizard Welcome screen appears.

4 Click the Next button. The terms of the license agreement are displayed.

5 Click the Yes button to accept 
the terms.

The Customer Information screen appears.

6 Enter your name, your company 
name, your reference, and your 
serial number in the Customer 
Information screen. Then click 
the Next button.

You are prompted to enter choose an installation 
folder on your computer. By default, this folder is 
c:\Program Files\Schneider Electric.

7 Specify an installation folder 
(and click the Next button.

8 Select Program Folder and click 
the Next button.

9 If you want to create a shortcut on 
the desktop click the Yes button.

InstallShield installs Vijeo Designer or one of its 
components.

10 Click the Finish button when the 
installation is complete. Then 
click the Exit button to return to 
your desktop.

Note: At the end of the installation process, the program may ask you to restart your 
computer. You must restart to update all newly installed components in the system.
16   35007035 04 03/2006



General
Software Version Compatibility

Title of Overview 
Block

Once the software has been installed (See Installing Vijeo Designer, p. 16), you as 
a user need to understand how this version of Vijeo Designer works with previous 
versions of the software.

Compatiblity 
with Older 
Versions of the 
Software

Projects created in this version of Vijeo Designer are not backward-compatible with 
previous versions of the software. A new project created and opened with this 
version of Vijeo Designer cannot be opened with an earlier version.

Projects created with an earlier version of Vijeo Designer are forward-compatible 
with this version. However, before opening an application that was created with an 
earlier version of Vijeo Designer, you should perform a complete backup of the initial 
project using the export feature.

Note: Before starting Vijeo Designer for the first time, read the Readme.chm file, 
which can be accessed from the Start → Run → Program Files → Schneider 
Electric → Vijeo Designer menu.
  35007035 04 03/2006 17



General
Uninstalling Vijeo Designer

Two Ways to 
Uninstall the 
Software

Vijeo Designer may be uninstalled in either of two ways:

using the Uninstall utility in the software
with the Add/Remove utility on your computer’s Control Panel

Using the 
Uninstall Utility

 

Using the Add/
Remove 
Programs Utility

 

Step Action

1 Close any applications running on the desktop.

2 Click Start → Run, and enter the path to the Uninstall utility in the installation folder 
for Vijeo Designer (for example, c:\Program Files\Schneider 
Electric\Vijeo designer\Uninstall). 

3 Click the OK button.

4 At the end of the uninstall process, restart your computer to update the system.

Step Action

1 Close any applications running on the desktop.

2 Click Start → Settings → Control Panel.

3 Select Vijeo Designer from the list of programs and click the Remove button.

4 At the end of the uninstall process, restart your computer to update the system.
18   35007035 04 03/2006
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Project creation
At a Glance

Purpose of this 
Chapter

This chapter gives some procedures that describe how to produce a simple 
application using Vijeo Designer's main functions.

What's in this 
Chapter?

This chapter contains the following sections:

Section Topic Page

2.1 Creation of Panels 21
19
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Project creation
2.1 Creation of Panels

At a Glance

Subject of this 
Section

This section describes the procedure to be followed to create the project screens. 

What's in this 
Section?

This section contains the following topics:

Topic Page

Description of Requirement 22

Project Construction Steps 23

The Application at a Glance 24

Starting Vijeo Designer 28

Basic Settings 29

Creating Variables 31

Creation of ‘Tank’ Panel 35

Numeric and Textual Display 39

Graphical Object 43

Creation of a Recipe 51

Creation of "Curves" Panel 56

Creation of "Alarms" Panel 58

Creating a Script 62

Simulation 65
  35007035 04 03/2006 21



Project creation
Description of Requirement

At a Glance In order to discover some of the things you can do with Vijeo Designer, we are going to 
develop a project. To do this, we need to describe our requirement or specifications.

The application must satisfy the following criteria:

manage the filling of a tank according to a filling setpoint and an alarm level. The 
setpoint and alarm level are selected by the user from a range of presets.  We will 
use the recipes function for selection of presets,
empty the tank by opening/closing the bottom valve when a button is pressed,
view the setpoint values in a numeric display and as a trend graph,
have an overview of the variation in level over time. To do this, we use a trend graph,
inform the user when a threshold is exceeded via a lamp and an alarm page.
22   35007035 04 03/2006



Project creation
Project Construction Steps

At a Glance The following steps must be taken and the following points addressed to create the 
project manual: 

launch Vijeo-Designer,
create the project manual,
configure the project,
declare the variables,
create the different panels and screen jumps,
create the numeric and textual displays,
use the graphical objects from the toolchest,
create the recipe,
create the trend graphs,
create alarm management,
create a script,
generate and simulate the project.
  35007035 04 03/2006 23



Project creation
The Application at a Glance

At a Glance The project to be designed is called "manual".

It consists of three screen pages:

"Tank",
"Curves",
"Alarms".

The "Tank"  (See The "Tank" Panel, p. 25) panel consists of: 

a tank taken from the animation toolchest,
two numeric displays (the level value and the alarm setpoint),
two types of recipe command which can be used to define the fill values and tank 
level alarms,
a tank emptying valve controlled by a button,
an upper threshold alarm lamp,
and a set of buttons used to switch from one screen to another.

The "Curves"  (See The "Curves" Panel, p. 26) panel consists of: 

the trend graphs object in which the tank level and alarm setpoint are animated,
and a set of buttons used to switch from one screen to another.

The "Alarms"  (See The "Alarms" Panel, p. 27) panel consists of: 

the alarm object which displays the high level alarm if the tank level is higher than 
the alarm setpoint,
and a set of buttons used to switch from one screen to another.
24   35007035 04 03/2006



Project creation
The "Tank" Panel The tank is filled to a selected product quantity (small quantity and large quantity). 
The quantity is managed by a recipe. The recipe also manages the threshold not to 
be exceeded depending on the desired quantity (alarm setpoint). You can modify the 
alarm setpoint by clicking (for a simulation) or by touching the numerical display for 
the "level of alarm" (on the XBTG's tactile screen). The high level alarm is activated 
if the tank level is higher than the alarm setpoint. Activation of the alarm causes a 
lamp to light up (red if threshold exceeded). The level changes in the tank. An 
emptying button enables you to empty the tank via the bottom valve. The bottom 
valve is animated when you press the "emptying" button. When closed the valve is 
shown in gray. When it is open it is shown in red.

The following diagram shows the "Tank" page: 

Number Description

1 Screen browser button

2 High level lamp

3 Tank with animated level

4 Tank bottom valve

5 Tank emptying button

6 Data entry zone for setpoint using numerical keypad

7 Recipe selector

8 Recipe command buttons 

6

1

5

Small quantity

Medium quantity

Large quantity

Emptying

25
27

Tank Level:

Alarm level:

Send Small quantity

4

3

2 8

7

CurvesTank Alarms
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Project creation
The "Curves" 
Panel

In this screen, the variation in the tank level and the alarm setpoint is represented in 
graphic form.

Illustration of the "Curves" panel: 

Number Description

1 Screen browser button

2 Trend graph showing the tank level and setpoint

0
10
20
30
40
50
60
70
80
90

100

1

2

CurvesTank Alarms
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Project creation
The "Alarms" 
Panel

This screen enables you to view the state of the level alarm.

Illustration of the "Alarms" panel: 

Number Description

1 Screen browser button

2 Alarm table for viewing active, acknowledged or elapsed/resolved alarms

2

Message Hour State

1 CurvesTank Alarms
  35007035 04 03/2006 27



Project creation
Starting Vijeo Designer

Procedure To start Vijeo Designer, select Start \ Programs \ Vijeo Designer or double-click 
the Vijeo Designer icon on the desktop.
28   35007035 04 03/2006



Project creation
Basic Settings

At a Glance Configuring your project correctly is essential before you begin to create a drawing. 
This project uses internal and external variables. 

A project created in Vijeo Designer is a simple chain of information (database). Within a 
project, the target terminals are configured and organized in a hierarchical structure.

Each target shows the hardware environment (PLC device) in which the project will be run. 

Create a Project 
and Configure its 
Target 

The following table describes the procedure to follow to create a project and select 
the remote device:

Step Action

1 This dialog box appears when Vijeo Designer is started. Click "Next" to continue. 

Note: If the above dialog box is not displayed when you start Vijeo Designer, you 
must select the "Vijeo-Manager" tab in the navigator, then right-click "Vijeo-
Manager" and select "New Project".

Vijeo-Designer

Don't show this dialog box again

Create new project

Open last project 

Finish< Back Next > Cancel

Welcome to Vijeo-Designer

What would you like to do?

Open existing project 
  35007035 04 03/2006 29



Project creation
2 Enter the name of your project and click OK (in our case, type "Manual_V42").
Click on Next then select module type XBT G2230.
Click on Next, select the IP address if the model uses an Ethernet port then click 
Next.
Select the relevant driver for the device type using the Add button (in our 
example, enter Schneider Electric Industrie SAS as the Manufacturer and 
Uni telway as the driver) then click on Finish.

New folders (panels, scripts, alarms, popup windows, languages, data files, etc.) are 
created. 

Note: To add another "Target" to the project, right-click "My Project" then select 
"New Project".

3 Save your project.

Step Action

Property Inspector

Target

Name Target1

Description

Type XBTG Series

InitialPanelID

XBTG2330 (320x240)

Buzzer

1: Tank

Enable

Download

TargetColor 256 Colors

ToConfiguration Top Left Corner

Model

Startup option

Data Sharing

Printer

Security

Input Mode

Alarm Banner

System keypad

Disabled

Disabled

Disabled

Ethernet

Ethernet
File System

Serialcal
30   35007035 04 03/2006



Project creation
Creating Variables

At a Glance A variable is a memory address indicated by a name. Vijeo Designer handles the 
following types of variables:

Boolean
Integer
Floating
Character string
Structure
Integer block
Floating point block

Vijeo Designer uses the variables to communicate with devices. You can also define 
internal variables that will only be used by Vijeo Designer.

In our project, we are going to create three internal variables and one external 
variable which communicates with a Uni-Telway device.

The following table describes the procedure to follow for creating variables:

Step Action

1 Click the "Variables" tab in the "Navigator" window, right-click on Target1 and 
select "New Variable" then the type "Discrete". 

Variable List: Sort By Target Name, Filter

ToolchestVije.

Target1

VariablesDesigner

Vi
jeo

Project

Paste Ctrl+V

New Variable New...

Floating

String

Discrete

Integer

Integer Block

Floating Point Block

Structure

Import Variables Ctrl+I

Ctrl+EExport Variables

Alt+EnterProperties
  35007035 04 03/2006 31



Project creation
2 You will now change the name of the Boolean-type "DISCRETE01" variable to 
"High_level" from the variable properties window. In this window, specify the variable 
source (external in this case). The variable has %M0 as its Device Address  

3 The "High_level" variable is an alarm. In its properties enable the Alarms function.  

Step Action

Too...Vij... Var...Designer

Vi
jeo

Pro...

Variable List: Sort By Target Name, Filter

Target1

High_level[%M0]

- Variable

Name High_level

Description

ArrayDimension 0

DataType Discrete

Source External

+ Alarm Enabled

+ KeepHistory Enabled

Scan Group UniTelway01Device

 Indirect Address ...
 Device Address %M0 ...
32   35007035 04 03/2006



Project creation
4 Repeat steps 1 and 2 to create the following internal variable of Discrete (Boolean) 
type: "Emptying".
You have now created two Boolean variables. 

5 Click the "Variables" tab in the "Navigator" window, right-click on Target1 and 
select "New Variable" then the type "Integer". 

Step Action

Too...Vij... Var...Designer

Vi
jeo

Pro..

Variable List: Sort By Target Name, Filter

Target1

Emptying

High_level[%M0]

Variable List: Sort By Target Name, Filter

ToolchestVije.

Target1

VariablesDesigner

Vi
jeo

Project

Paste Ctrl+V

New Variable New...

Floating

String

Discrete

Integer Block

Floating Point Block

Structure

Import Variables Ctrl+I

Ctrl+EExport Variables

Alt+EnterProperties

Integer
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6 You will now change the name of the "Integer01" variable of "integer" type to "Level" 
from the variable properties window. In this window, specify the variable source 
(external in this case). The variable has %MW0 as its Device Address  

7 Repeat steps 5 and 6 to create the following internal variables of Integer type: "Setup".
Now, in the Variable tab, you will see this list. 

Note: It is possible to access the variable properties by double-clicking on the 
variable. A window with five tabs is displayed, making variable configuration easier 
to access and understand.

Step Action

Too...Vij... Var...Designer

Vi
jeo

Pro...

Variable List: Sort By Target Name, Filter

Target1

High_level[%M0]

Level[%MW0]

Emptying

Too...Vij... Var...Designer

Vi
jeo

Pro..

Variable List: Sort By Target Name, Filter

Target1

Level[%MW0]

Emptying

Setup

High_level[%M0]
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Project creation
Creation of ‘Tank’ Panel

Illustration The graphic below shows the panels to be created in this phase: 

CurvesTank Alarms
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Procedure The following table describes the procedure to follow to create the panels:

Step Action

1 Click the "Project" tab in the navigator.

2 Double-click "Graphical Panels" to open the folder.

3 Click on "1:Panel1",
Rename "1:Panel1" as "1:Tank".

4 In the "Properties" window, change the background color to light gray, which gives a color code of 
"192,192,192".

5 Create two other panels using the same background colour as the Tank panel.
Right-click on Graphical Panels and select New Panel
Panel 2 is called Curves and panel 3 is called Alarms.

Navigator

Vijeo.Manager Variables Toolchest...

Manual
Target1

1: Tank
2: Curves
3: Alarms

Init
Decrement
alarm

Application Scripts

Alarms
Popup Windows

Data Files

Recipes
1: TankSetting

IO Manager
UniTelway01 [COM1]

UniTelway01Equipment1

Ressource Library

Languages [Language1]

ProjectDeVi

Graphical Panel
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Project creation
Create a Panel 
Browser Button

The following table describes the procedure to be followed to create a button used 
to jump between pages:

Step Action

1 Select the "Switch" icon in the toolbar and draw an area on the panel where the button will be placed. 

To define an area where the object is to be placed, simply:
left-click in the screen where you wish to position your object,
release the left mouse button,
drag the mouse to obtain the desired size of your object on the screen,
left-click in the screen a second time once you are happy with the object size,

A 123
A A..
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2 When the "Switch Settings" window is displayed, in the General tab:
enter the name "Button_tank",
select the category primitive and the button style 00002, 
When Touch , select Panel in Operation, select Change Panel for Tank (Id=1) then click on Add.

3 In the Color tab, select a dark green (code 0.128.0) for the foreground color.

4 In the Label tab, the label type must be static and you must enter Tank in the free text field.

5 Click on OK to confirm the configuration.

6 Repeat the operation for the buttons for the Curves panel (Id=2) and the Alarms panel (Id=3).

7 At this stage, in the current panel you will now have 3 buttons enabling you to jump between pages. Select 
these 3 buttons to copy (Ctrl+C) and paste (Ctrl+V) them into the two other panels.

Step Action

HelpCancelOK

Button_tankName

General Label Visibility

Switch Settings

Add  >Apply

1: Tank

1

00002

Primitive

State

Lamp

Mode Switch Switch with Lamp

Style

Category

Reverse On Touch

Change Panel

Panel ID:

Previous Panel

Color Advanced

While Touch When ReleaseWhen Touch

Operation Panel

[Up]

Change Panel[1]
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Project creation
Numeric and Textual Display

Illustration The graphic below represents the Tank screen phase to be created: 

25
27

Tank level:

Alarm level:

CurvesTank Alarms
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Project creation
Create Text The following table describes the procedure to be followed to create text:

Step Action

1 Select the "Text" icon in the toolbar and draw an area on the screen where the text will be placed. 

2 The Text Editor window is displayed. Configure the text properties as shown in the screen below and click on OK: 

3 In the "Properties" window, change the Text Color to black 0,0,0.

4 Do the same for the text Alarm level.

A 123
A A..

Text Editor

CancelOK

Tank level:

Vijeo Modern 8x13

1: Language1

Normal

Language:

Font:

Font Style: 13Font Height:

8Font Width:
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Create a Numeric 
Indicator

The following table describes the procedure to follow to create a numeric display:

Step Action

1 Select the "Data Display" icon in the toolbar and draw an area on the screen where the numeric window will be placed. 

2 The Numeric Display Settings window is displayed. Configure the properties as shown in the screen below: 

3 In this window, from the "General" tab:

Click the  icon then:

double-click on the "Level" variable then on OK in the expression editor,
enter 3.0 in the "Display Digits" field,
Click OK.

A 123
A A..

HelpCancelOK

NumericalDisplay01Name
00026

Integer Floating
Style

Data 
Type
Variable Level

Dec.Display Zero(s)

3 0Zero Suppress

Format

1: Language1

Display Digits

Language

Vijeo Modern 6x10Font

BoldFont Style

6

10

Font Width

Font Height

Alignment

.

General Input Mode VisibilityColor Advanced

Numeric Display Settings

1 2 3
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4 In the "Color" tab:
select the color dark blue 0,128,128 for the "Back Color".

5 Click OK.

6 Repeat thse steps for the ‘Setup’ variable.
For the ‘Setup’ variable, you must authorize the user to change its value. To do this, check Enable Input Mode 
in the Input Mode tab. The option Display Popup Keypad is automatically selected. It enables a numerical 
keypad to be displayed on the product screen when the user enters Edit variable mode.

7 Save your project.

Step Action

Note: You can access and modify an object's settings in the "Properties" window.
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Project creation
Graphical Object

Illustration In this section, the user adds the tank, the bottom valve, the valve piping, and the 
valve command button and high level indicator. After performing the steps below, 
the screen looks like this: 

Emptying

25
27

Level of the tank :

Level of alarm :

CurvesTank Alarms
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Import an Object 
from the 
Toolchest

The following table describes the procedure to be followed to use an object from the 
toolchest which provides a schematic representation of the tank:

Step Action

1 The tank can be found in the toolchest tab. It is located in the Tank Graph directory. Take the object 
TankGraph_0001 and drag-and-drop it into the Tank panel. Resize the object as required by dragging any of 
the points that appear around the object when you select it.
  

2 In the "Properties" window click on the  icon. The Variable List window is displayed. Double-click on the 

‘Level’ variable to animate the tank level.

Navigator

Toolchest
Text Display

Tank Graph

Image Library
Dial
Keypads
Logging Trend Graph
DateTime
Diagnostics
Other
Circular Graph
Data Graph
Bar Graph

Pie Graph
Models
Recipes
User
Lamps

Vijeo.Manager VariablesProjectD V Toolchest...

.....
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Create a Line The following table describes the procedure to be followed to create a line 
representing the piping of the bottom valve:

Step Action

1 Select the "line" icon from the tool bar and draw an area on the screen where the line will be placed (in our 
example, it starts at the bottom of the tank and ends at the bottom of the screen). Adjust the position of the 
line (or object) using the arrow keys on your keyboard. 

2 In the "Properties" window, enter:
"0,0,0" black as the line color,
"4" as the line thickness.

A 123
A A..
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Project creation
Create Valve In this project a polygon shape is used to represent the valve. It is animated 
differently according to whether it is open (green) or closed (gray).

The following table describes the procedure to be followed to create the valve:

Step Action

1 Select the "Polygon" icon in the toolbar and use it to draw a valve, defining an area on the screen where the 
valve will be placed. 

2 The Animation Properties window is displayed. Configure the properties as shown in the screen below: 

3 In this window, in the "Color" tab:
check Enable Fore Color Animation,

Click the  icon then:

double-click on the Discrete "Emptying" variable then on "OK",
change the OFF and ON colors (OFF in gray and ON in green).

4 Click OK.

A 123
A A..

HelpApplyOK

DiscreteEnable Fore Color Animation

Fore Color

Animation Properties

Cancel

Data Type:

Back Color Line Color

Visib.TouchRotatePositionSizeFillColor

Value Color

Emptying

OFF
ON
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Project creation
Create Warning 
Signal

In this project the lamp is used for signaling. It is animated depending on whether 
the alarm is triggered (red) or untriggered (grey) for "High_level".

The following table describes the procedure to be followed to create the lamp:

Step Action

1 Select the "Lamp" icon in the toolbar and use it to draw a Lamp, defining an area on the screen where the lamp 
will be placed. 

2 In this window, from the "General" tab:

Click the  icon then:

select the "Discrete" "High_level" variable,
retain the lamp style 10001.

A 123
A A..
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3 In the "Color" tab:
select a dark gray ‘128.128.128’ for the foreground color of the OFF state,
select a red ‘255.0.0’ for the foreground color of the ON state combined with fast blink,

4 Click OK.

Step Action

CancelOK

General Color Label

LED-Parameters

Help

View

Primitive

10001

02Lamp Category

Style
High-level

Name

Variable

State [Off]

Front color

Back color

Pattern

Blinking

 Off

Front color

Back color

Pattern

Blinking

On

AucunNone AucunNone

Aucun1: Aucun1:

Text color

3D color

Border color

Text color

3D color

Border color
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Create a 
Command 
Button

In this project, the "emptying" button enables or disables the "emptying". It is also 
used to animate the bottom valve.

The following table describes the procedure to be followed to create a command button :

Step Action

1 Select the "Switch" icon in the toolbar and use it to draw a rectangle, defining an area on the screen where 
it will be placed. 

2 The Switch Settings window is displayed. Configure the properties as shown in the screen below: 

A 123
A A..

HelpCancelOK

Switch03Name

General Label Visibility

Switch Settings

Add >Apply

00003

Primitive

State

Lamp

Mode Switch Switch with Lamp

Style

Category

Reverse On Touch

Toggle

Color Advanced

While Touch When ReleaseWhen Touch

Operation Bit

[Up]

Bit Toggle [Emptying

Momentary ON

Momentary OFF

Emptying

Destination

Set

Reset

Operation
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3 In the General window:
select 00003 as the switch style.

in the "When Touch" tab, click on the  icon and:

select the "Discrete" "Emptying" variable,
select Toggle which will switch ON the Emptying bit when the button is first pressed and switch it OFF 
when the button is pressed again.
click on Add to confirm the selection.

4 In the "Label" tab:
select static for the label type,

enter ‘Emptying’ in the data entry window,

5 In the "Color" tab:
select the white ‘255.255.255’ as the foreground color,
select the black ‘0.0.0’ as the text color.

6 Click OK.

Step Action
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Creation of a Recipe

Illustration This sections explains two ways of implementing recipe commands:

using a command button,
using the recipe selector.

In this project, we have created 3 recipes to determine the level and alarm setpoint 
values according to the selected recipe:

Small quantity is the first recipe. It is used to fill the tank to 25% of its capacity and 
sets an alarm level at 27%,

Medium quantity is the second recipe. It is used to fill the tank to 50% of its 
capacity and sets an alarm level at 52%,

Large quantity is the third recipe. It is used to fill the tank to 80% of its capacity 
and sets an alarm level at 82%.

After performing the steps below, the completed screen looks like this: 

Small quantity

Medium quantity

Large quantity

Emptying

25
27

Tank level :

Alarm level :

Send Small quantity

CurvesTank Alarms
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Project creation
Create the 
Recipe

The following table describes the procedure to be followed to create the recipe:

Step Action

1 In the project tab, right-click on "Recipe".

2 Create a new recipe group.

3 Rename the new recipe group ‘Tanksetting’.

4 Configure the recipe names as follows: 

Right-click on Recipes and select New Recipe to create recipe 2 
Right-click on Recipes and select New Recipe to create recipe 3
Click on the arrow, as shown in the graphic, to expand the window,
Rename recipe 1 as Small and, in the Language 1 column, enter Small quantity,
Rename recipe 2 as Medium and, in the Language 1 column, enter Medium quantity,
Rename recipe 3 as Large and, in the Language 1 column, enter Large quantity,

3 recipes will now have been created.

5 Configure the recipe names as follows: 

Click on the arrow, as shown in the above graphic, to minimize the window,

Click on Recipes, as shown in the graphic, to select all the recipes and perform the following configuration 
steps,

Recipes Access Rights Language1ID

Small quantity

Medium quantity

Large quantity

0

0

0

1

2

3

Small

Medium

Large

Recipes

recipe1

recipe2

recipe3
Click to resize window

Recipes

Small

Medium

Large Click to select all recipes
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3 Configure the recipes as follows: 

Fill in line 1 by double-clicking to enter data,
Add an ingredient by right clicking on line 1 and selecting New Ingredient which enables you to create line 2
Fill in line 2 by double-clicking to enter data,

6 Save your project.

Step Action

01

Ingredients Varia... Label Editable Min Max Small Medium Large

Level

Setup

Level

Alarm setup 0

100

100

25

27

50

52

80

822
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Create Button-
Operated Recipe 
Command

In this project, three recipes are declared so you need to design and configure three 
command buttons.

The following table describes the procedure to be followed to create a command 
button for a recipe:

Step Action

1 Select the "Switch" icon in the toolbar and use it to draw a rectangle, defining an area on the screen where 
it will be placed. 

2 The Switch Settings window is displayed. Configure the properties as shown in the screen below: 

A 123
A A..

HelpCancelOK

Switch04Name

General Label Visibility

Switch Settings

Add >Apply

00002

Primitive

State

Lamp

Mode Switch Switch with Lamp

Style

Category

Reverse On Touch

Assign

Color Advanced

While Touch When ReleaseWhen Touch

Operation Word

[Up]

Word Set [RecipeGroup
Word Set [RecipeGroup

1

Add

Subtract

AND

OR

Exclusive OR

Source

Operation

RecipeDefaultControl.recipeNumber
Destination
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Project creation
Repeat all these steps to create each of the command buttons for the Medium and 
Large recipes using this assignment table:

Create a Recipe 
Selector

The recipe selector can be found in the toolchest. It is located in the recipe directory. 
In the "Tank" panel, drag in the "Recipeselect" object and the "send" object.

3 In the General window:
select 00002 as the switch style.

from the "When Touch" tab:
select a Word operation,
Enable 1 in Source.

in Destination, click on the  icon and select RecipeDefaultControl.RecipeNumber. 

click on Add to confirm selection of recipe number 1.
Repeat the operation, enabling for source 1 the destination RecipeDefaultControl.RecipeOperation,
click on Add to confirm the choice to send a recipe command.

4 In the "Label" tab:
select static for the label type,

enter ‘Small quantity’ in the data entry window,

5 In the "Color" tab:
select the yellow ‘255.255.0’ as the foreground color,

6 Click OK.

7 Save your project.

Step Action

Small Medium Large

RecipeDefaultControl.RecipeNumber (Recipe number) 1 2 3

RecipeDefaultControl.operation (recipe operation) 1 1 1

Button color and color code yellow
255.255.0

salmon pink
255.128.64

brown
128.128.0

Button label Small quantity Medium quantity Large quantity
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Creation of "Curves" Panel

Illustration The ‘Curves’ panel and the ‘page jump’ button group have already been created in  
(See Create a Panel Browser Button, p. 37). The purpose of this section is to import 
the trend graph object and to configure the "Level" and "Setup" variables to be able 
to view their values as graphs.

The graphic below represents the screen to be created: 

Create Trend 
Graph

The following table describes the procedure to be followed to create the trend graph 
for the ‘Curves’ panel:

0
10
20
30
40
50
60
70
80
90

100

CurvesTank Alarms

Step Action

1 Select the "Trend Graph" icon in the toolbar and draw an area on the panel where the object will be placed. 

A 123
A A..
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2 Configure the trend graphs in the properties window:
enter the "Level" variable for channel1,
Enable channel2 and select the "Setup" variable. 

3 Save your project.

Step Action

Properties

Name
Hi
Left
Width
Height
Description
PlateColor
BorderColor

GraphSettings
RangeSettings
DataAxisLabel
DataAxisScale
DataGridLine
TimeAxisScale
TimeAxisGridLine
Channel1

Channel2
Variable
DisplayFormat
Track
Mark
Color
OutOfRangeColor

Channel3
Channel4
Channel5
Channel6
Channel7
Channel8

SaveDefaults
RestoreDefaults

Trend_Graph
40
41
259
180

Enabled
Enabled
Enabled
Enabled
Enabled
Enabled

Line
Disabled
Disabled

Disabled
Enabled
Setup
Line
Disabled
Disabled

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

DisplayFormat
Track
Mark
Color
OutOfRangeColor

Trend_Graph

(0,0,0)
(255,255

...

...

>>>

<<<

Variable Level
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Creation of "Alarms" Panel

Illustration The Alarms panel and the ‘page jump’ button group have already been created in  (See 
Create a Panel Browser Button, p. 37). The purpose of this section is to demonstrate 
how to use the alarm object and configure it to view alarms on this screen.

The graphic below represents the Alarms screen page to be finalized: 

Message Hour State

CurvesTank Alarms
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Import and 
Configure Alarm 
Object

The following table describes the procedure to be followed to use the alarm table:

Step Action

1 Select the "Alarm Summaries" icon in the toolbar and draw an area on the screen where the object will be placed. 

2 Double-click on the object to configure in the Alarm Summary Parameters window.
In the Basic tab:

select the Log display mode to display changes in alarm state (active, acknowledged, elapsed).
  

A 123
A A..

HelpCancelOK

Enable Action

AlarmGroup1Alarm Group

Basic Color

Alarm Summary Settings

Display Mode

TimeSort By

Description

AlarmSummary01Name yy/mm/ddDate Format

24:00:00Time Format

UpScroll Direction

ArrowCursor Type

Cursor On Action

Direct Selection
AutoCursor

Show Column Title

Font Column Display Buttons

Log

Note: The column display may be configured as required. In this Alarms page, we 
have chosen to display the message with a column width of 120, and the alarm 
date and time with column widths of 80.
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Configure Alarm 
Group

The following table describes the procedure to be followed to configure the alarm 
group:

Step Action

1 Click the "Project" tab in the navigator.
   

2 Double-click "Alarms" to open the folder.

3 Click on "AlarmGroup1" to open the alarm group configuration window.

Navigator

Vijeo.Manager Variables Toolchest...

Manual
Target1

Graphical Panel
1: Tank
2: Curves
3: Alarms

Init
Decrement
alarm

Application Scripts

Alarms
Popup Windows

Data Files

Recipes
1: TankSetting

IO Manager
UniTelway01 [COM1]

UniTelway01Equipment1

Ressource Library

Languages [Language1]

ProjectD V
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4 To the High_level alarm, add the message "Tank in high level" as shown in the following screen: 

When the alarm is triggered, "Tank in high level" will be displayed in the message column.

5 Save your project.

Step Action

Alarm Group Setting

Variable Alarm Group Data Source Device Address Message
Tank in high levelExternalAlarmGroup1High_level %M0

%M0Device Address

Tank in high levelMessageAlarmGroup1Alarm Groups

AlarmSummary01Variable

...

... 1: language1Language ...
Configuration
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Project creation
Creating a Script

At a Glance In Vijeo Designer, a script can be used to automate some of a communication 
program's tasks. You can use a script to define a procedure that runs when a 
condition is met. 

You can then add a function that is not available in a drawing's properties.

In this project, we create three scripts:

Init, which is triggered when the product is powered up. It is used to select recipe 
number 1.
Decrement, which is triggered on activation of the "Emptying" variable at a 
frequency of 0.3 seconds. It is used to simulate emptying of the tank.
Alarm, a periodic script which manages the ‘High_level’, alarm. The condition 
which triggers the alarm is normally a condition written to the PLC. For the 
purposes of this tutorial, this variable is animated internally.

Create the Init 
Script

The following script is executed once (on startup).

The following table describes the procedure to be followed to create the "Init" script:

Step Action

1 In the navigator window, click on the "Project" tab , then right-click on "Application 
Script" and select "New Script"

2 Select "On Startup" in the "Trigger" field of the "Properties" window: 

rename "script_1" as "Init".

3 Click on "Init" to open the script editor window and enter the following program:
//Set Recipegroup
RecipeControlDefault.RecipeGroupNumber.write(1);

Note: To insert a variable in a script, you can right-click and select Insert, Variable 
then the command element associated with the variable

Properties
Panel Script

Name init
Trigger On Startup
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Create the 
Decrement 
Script

The following script is executed every 0.3 seconds if the "Emptying" variable is 
enabled. It is used to simulate emptying of the tank.

The following table describes the procedure to be followed to create the 
"Decrement" script:

Step Action

1 In the navigator window, click on the "Project" tab , then right-click on "Application 
Script" and select "New Script"

2 Select "Conditional" in the "Trigger" field of the "Properties" window. In the  
Trigger Condition field, select While True, for the Frequency enter 1 and for the 
Trigger Variable "Emptying": 

rename "script_2" as "Decrement".

3 Enter the following program:
//creating temporary variable int tmp;
int tmp;
//Set value of Level in tmp
tmp = Level.getIntValue ();
//If value of level>0
if (tmp>0)
{
   //then decrement tmp
   tmp --;
   //Then write tmp’s value in Level variable
   Level.write ( tmp );
}

Properties
Application Script

Name decrement
Trigger Conditional
Frequency [secs] 1
Scheduling Low
Trigger Variable Emptying
Trigger Condition While True
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Create the Alarm 
Script

The following script is executed periodically every second. It manages the 
"High_level" alarm. The condition which triggers the alarm is normally a condition 
written to the PLC. For the purposes of this tutorial, the "High_level" variable is 
animated internally.

The following table describes the procedure to be followed to create the "Alarm" 
script:

Step Action

1 In the navigator window, click on the "Project" tab , then right-click on "Application 
Script" and select "New Script"

2 Select "Periodic" in the "Trigger" field of the "Properties" window, specifying a 
Frequency of 1.0 second: 

rename "script_3" as "Alarm".

3 Enter the following program:
//If Level > Setup of alarm
if (Level.getIntValue() > Setup.getIntValue())
//Then Alarm (High_level) actived else alarm desactived 
  High_level.write(1);
else
  High_level.write(0);

4 Save your project.

Properties
Application Script

Name Alarm
Trigger Periodic
Frequency [secs] 1
Scheduling Low
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Project creation
Simulation

Simulating your 
Project

The simulation function can be used to display your project without downloading it 
to an XBT G terminal. It is a good way to check and validate your project, and make 
sure things are the way you want.

Start Simulation Use the following procedure to run the simulation and check your project:

Step Action Result

1 Click the Project tab in the Navigator 
window.

2 Right-click Target 1.

3 Select Start Device Simulation. The main screen of your project appear

4 Test your project as it is so far. It should behave like the Exercice_1 
project presented at the beginning of the 
Tutorial. For example:

Choose a recipe. Does the value 
appear on the tank graphically and in 
the numeric display?
Click on the numeric display (level of 
alarm) and enter number 10 with the 
keypad that pops up. When the alarm 
appears, does the light blink?
Click the navigation button to move to 
the second screen. Do the values 
appear on the curve?
Click on the alarms button to move to 
the third screen. Do you get there?
Return to the first screen. Click on 
emptying button. Does the tank empty?

5 To stop the simulation, press either 
CTRL+Z or ALT+F4 or click on the Close 
icon of the simulation windows.

If you find that some elements are not 
working properly, go back to the 
appropriate panel, select the element(s) 
and review the properties.

6 When everything is fine, go to the next 
procedure to trigger the alarm.
Note: When re-testing your project after 
making corrections, you must close the 
simulation before running a new one.
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Project Download
At a Glance

Purpose of this 
Chapter

This chapter describes the different project build types and the various project 
download modes.

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

 Validating, Building, and Correcting Errors 68

Downloading a Project 70
67



Project Download
 Validating, Building, and Correcting Errors

Types of Data 
Transfer

Use one of the following methods to transfer a customer application to a terminal (or 
perform a local simulation):

* Data created using the Build function.

Validating the 
Target

To make sure that all the parameters of the project you want to build are present and 
correct, use the Build → Validate all command from the main menu.

Building the 
Target 

The objective is to build a program that can be run directly by the XBT G panel from 
the project created with the Vijeo Designer graphical editor.

Before starting the build, use the Build → Clean All command. This command 
cleans the project folder for each target and/or project so that they are free of 
unnecessary files.

After cleaning the target folders, use the Build → Build All command to build your target.

Vijeo Designer can build a program in any of four possible ways:

Type Procedure

Ethernet The application produced by the built project* is transferred to products 
equipped with an Ethernet port over the network. 

Tool port Data produced by the built project* is transferred to the device connected 
to the PC using XBT ZG915 or XBT ZG925 cables.

CompactFlash 
card

Data produced by the built project* (on a PC equipped with a PCMCIA card 
reader) is transferred by copying to a CompactFlash card. The card is then 
inserted in the terminals.

Local simulation Data produced by the built project* is stored locally for simulating the 
application during its fine-tuning phase.

Type Procedure

Build Rebuilds the project completely and optimizes the results file. Although 
creation is quicker than when using the Build function.

Quick Build Builds only the data updated since the previous version was built, and 
optimizes the results file. 

Start simulation Rebuilds the project completely and refreshes the resulting file. When the 
build is complete, the simulation starts.

Download Before download, the target is validated and built. If no errors are detected, 
the user application files are transferred to the target machine.
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Error Correction When the build process completes, the Feedback zone window opens 
automatically, and all detected errors and warnings are displayed. Errors are 
displayed in red, and warnings are displayed in yellow. When there are no errors or 
warnings, the result is displayed in green.

To view detailed information on a specific error or warning, double-click on that error 
or warning message.
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Downloading a Project

Data Download 
Types

When you send an application to its target, you use a download method. Several 
download methods may be used:

downloading over an Ethernet network
a file system method, where data is downloaded to a CF card
using the unit's serial port to download directly to the target.

Select the method you want to use in the Target area of the Property Inspector window.

For more information, see the online help.

Note: At this stage, you can test your project on an XBT G panel. Keep in mind that 
the project will behave just as it did when it was simulated on the PC (See 
Simulating your Project, p. 65). To implement a real application, the input value 
should come from a field sensor, not from the keyboard.
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Download 
Procedure

Use the following procedure to download an application to an XBT G target:

Step Action

1 Connect one end of the download cable to the XBT G tool connector or to an Ethernet 
cable connector and the other end to the COM1 or Ethernet port on your computer.
XBT G2110/2120/2220/4320: only tool connector (serial)
Other XBT G units allow you to choose an Ethernet or tool connector connection.

2 Click the Project tab in the Navigator window, and click Target1.

3 In the Download field of the Property Inspector window, select either Ethernet or Serial. 

4 a. For an Ethernet download, be sure to enter your:
IPAddress
SubnetMask
DefaultGateway

b. For a serial download, be sure to enter a:
COM port
baud rate

5 In the Navigator window, and click Target1. then click right to select Download.

6 Check your XBT G unit to see if the application is displayed correctly.
Note: If an error message appears in the Feedback zone, the download has failed. 
You need to solve the problem before trying to download data again. Double-click on 
an error displayed in the Feedback zone to locate the error position.

Property Inspector
Target

Name Target1
Description
Type XBT G Series

InitialPanelID
XBT G2330 (320x240)

Buzzer

1: Tank

Enable

Download

TargetColor 256 Colors

ToConfiguration Top Left Corner

Model

Startup option

Data Sharing
Printer
Security
Input Mode
Alarm Banner
System keypad

Disabled

Disabled
Disabled

Ethernet
Ethernet
File System
Serialcal
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Exit Vijeo 
Designer

Before you exit Vijeo Designer, save your project. Then select File → Exit from the 
main menu.
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